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Acknowledgement of Country
Eastern Melbourne PHN acknowledges the Wurundjeri people and 
other peoples of the Kulin Nation on whose unceded lands our 
work in the community takes place. We pay our respect to 
Aboriginal and Torres Strait Islander cultures; and to Elders 
past and present. EMPHN is committed to the healing of 
country, working towards equity in health outcomes, and the 
ongoing journey of reconciliation.
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We recognise and value the knowledge and wisdom of people with 
lived experience, their supporters and the practitioners who work 
with them and celebrate their strength and resilience in facing the 
challenges associated with recovery. We acknowledge the 
important contribution that they make to the development and 
delivery of health and community services in our catchment.
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Audio:
Listen via your computer’s speakers

Telephone Number – within the audio 
section or access details supplied in 
registration email

Questions:
Post your questions in the ‘Questions’ 
section in the webinar panel or email 
hello@medicaldirector.com

digitalhealth@emphn.org.au

mailto:hello@medicaldirector.com
mailto:digitalhealth@emphn.org.au
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4.3 New Enhancements 

Recording measures 

Recording Immunisations

Recording Cervical Screening

Managing Recalls and recording contact

Recording social and family history including 
recording alcohol and smoking

Keeping past history items relevant
Creating letters 
Data Quality and Data Cleansing
User Preferences 
My Health Record accessing & uploading

AGENDA:

Agenda
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Grant Smith, 
Practice Consultant
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Barb Repcen, 
Program Specialist- Digital Health

EMPHN

Kylie Goodwin,
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4.3 New Enhancements 

Immunisations
• A new funding model option has been added for users 

to record whether or not a vaccine has been given as 
part of the National Immunisation Program

• A new Route of Administration field has been added for 
vaccines that have multiple options

• The AIR Immunisation screen now displays the 
patient's AIR demographic details to assist with patient 
identification

Patient's Record
• Add Progress Notes from anywhere in the patient 

workflow, via a new floating panel
• Added 7 new Quick Template buttons which can be 

configured as website links or quick launch buttons
• Keyboard shortcuts are now highlighted with an 

underscore, and new shortcuts have been added
• Added the option to record "No Next of Kin or 

Emergency Contact Provided" in the patient's record
• Updated ABS Ethnicity to the 2019 Australian Standard 

Classification of Cultural and Ethnic Groups
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Recording Immunisations

Conduct a live patient verification 
check with AIR.

Click to record a medical 
exemption for the given patient.

Click to record a planned catch 
up for the given patient.

Click to download the patient's 
immunisation statement from 
AIR.

https://www.medicaldirector.com/help/index.htm#t=topics-clinical%2FImmunisations.htm
https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm#Medical_Exemptions
https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm#Medical_Exemptions
https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm#Planned_Catch_Ups
https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm#Planned_Catch_Ups
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Recording Immunisations

 To Record an Immunisation

1. From the patient's Clinical Window, select the Imm. tab.

2. Then, to add an immunisation record, either

o Click         on the toolbar

o Press the F3 key

o Right-click in the list of immunisations (even if list is empty) and 
select Record Encounter from the pop-up menu

3. The Vaccination window appears.

o Indicate whether the vaccine was administered elsewhere (Optional). 
This sets the Vaccinator drop-down list to 'Given Elsewhere'. The 
'Vaccinator' and 'Consent provided by' fields remain disabled.

o Indicate whether you wish to forward this vaccination data to AIR. 
The Send to AIR check box will be ticked by default, if the following rules 
are met;

• Applies to any vaccine administered to a patient, that is approved for 
transmission by AIR.

• The vaccine must be administered at the surgery (i.e. not ‘declined’ 
or ‘given elsewhere’).

• MedicalDirector Clinical must be configured for sending vaccination 
data to your billing package, and;

• If you are linked to Pracsoft, you must also tick the 'Create 
Immunisations' check box, located in Links Options.

• If you are linked to a third-party billing package, you must also;

1 tick the 'Send details of immunisations recorded...' check 
box in Advanced Link Options.

2 Indicate the output path location for the vaccination data 
your billing package will read, also located in Advanced Link 
Options.

o Select the vaccinator from the drop-down list.

o Indicate who gave consent for the vaccination.

o Enter a date on which the immunisation was 
administered.

o Select the immunisation name from the list provided.

o Select the site at which the vaccination was 
administered.

o Indicate the route of administration.

o Indicate the Type of vaccine from the list provided.

o Enter the Sequence, Batch Number and any comments 
(if necessary). Note that in the example above we have 
enforced AIR batch number validation (via Advanced Link 
Options) and therefore batch numbers must contain only 
alpha-numeric characters (no spaces or punctuation).

o (Optional) Click Mark for recall button to generate 
a recall notification to have the patient recalled for another 
immunisation in the future. ERROR: Variable 
(Recall_Management) is undefined.

4. Click Save button to save the immunisation record and 
return to the patient's record.

https://www.medicaldirector.com/help/topics-clinical/Linking_MedicalDirector_Clinical_with_MedicalDirector_Pracsoft.htm
https://www.medicaldirector.com/help/topics-clinical/Links_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Advanced_Link_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Advanced_Link_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Advanced_Link_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Route_of_Administration.htm
https://www.medicaldirector.com/help/topics-clinical/Advanced_Link_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Advanced_Link_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
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Recording Immunisations 
To determine if a patient requires one or more 
vaccinations according to the National Immunisation 
Program Schedule, consult the Due Vaccines list on 
the Immunisation History tab. This list is generated in 
real time from the Australian Immunisations Register.

See Recording Immunisations for more information.

The Immunisations History tab displays the patient's 
immunisations history as recorded with the 
Australian Immunisation Register (AIR). History can 
include immunisations recorded at your practice, 
along with those recorded elsewhere.

o Red records indicate that some action is 
required.

o Black records are editable. Only immunisations 
administered at your practice are editable.

o Blue entries are those recorded with AIR, and 
are not editable.

Updating Encounters with AIR

1. Select the Immunisations History tab.

2. Locate the record you wish to update 
with AIR.

3. Right-click the record and select Update 
Encounter.

https://www.medicaldirector.com/help/topics-clinical/Immunisations.htm#Recording_Immunisations
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Recording Measurements

The Clinical Measurements window displays the 
progress of a patient's various clinical 
measurements. Measurement data is entered 
via Progress Notes and various Tools.

To view clinical measurements select Clinical > 
Measurements from with a patient's Clinical 
Window

•Measurements are listed on the left side of the 
window and separated into the various sections, 
including BMI, CVRISK, PEFR, SYSTOLIC, 
DIASTOLIC, for example.
•Measurement recording dates appear as 
column headings.
•To view specific measurements in graph form, 
select an entry and click Graph

https://www.medicaldirector.com/help/index.htm#t=topics-clinical%2FMeasurements.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Tool_Box.htm
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Recording Measurements

The Tool Box is a suite of tools for recording patient readings, either calculated manually or 
via a Diagnostic Devices, with each tool provided on a separate tab as shown in the 
following image.

The upper section of this window provides a means to;

o Mark the date and time on which the recordings were taken, and

o Test the tools using fictitious data (Sex at Birth and Age). Note that although you can 
change the patient's sex at birth and age here, these changes are not saved back to their 
record.

The lower section displays a selection of tool tabs. Some tabs require that you enter 
general data before recordings can be made. You will be prompted accordingly when this is 
necessary.

Blood Glucose
Blood Pressure
Cardiovascular Risk - Absolute Calculator
Cardiovascular Risk - Relative Calculator
Electrocardiogram
INR Record
Paediatric Percentile Charts
Renal Function Calculator
Respiratory Function
Weight

https://www.medicaldirector.com/help/index.htm#t=topics-clinical%2FTool_Box.htm
https://www.medicaldirector.com/help/topics-maintenance/Device_List.htm
https://www.medicaldirector.com/help/topics-clinical/Sex_at_Birth.htm
https://www.medicaldirector.com/help/topics-clinical/Blood_Glucose.htm
https://www.medicaldirector.com/help/topics-clinical/Blood_Pressure.htm
https://www.medicaldirector.com/help/topics-clinical/Cardiovascular_Risk_Calculator_Absolute_CVD_Risk.htm
https://www.medicaldirector.com/help/topics-clinical/Cardiovascular_Risk_Calculator_Relative_CVD_Risk.htm
https://www.medicaldirector.com/help/topics-clinical/Electrocardiogram.htm
https://www.medicaldirector.com/help/topics-clinical/INR_Record.htm
https://www.medicaldirector.com/help/topics-clinical/Paediatric_Percentile_Charts.htm
https://www.medicaldirector.com/help/topics-clinical/Renal_Function_Calculator.htm
https://www.medicaldirector.com/help/topics-clinical/Respiratory_Function.htm
https://www.medicaldirector.com/help/topics-clinical/Weight.htm
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Recording Cervical Screening via the Patient’s Record

1. Select the Cervical Screening tab in the patient's clinical record.

2. Either,

o Click

o Press F3

o Right-click within the list of recorded screens and select New 

Item from the menu that appears

3. The Record Cervical Screening Result window appears.

o Enter the date on which the screen was obtained from the patient.

o Select a result type from the list provided.

o Tick check boxes as appropriate to indicate whether Endocervical 
cells and/or H.P.V. changes were present.

o If you wish to generate a Recall notification for this patient, 
click Add Recall

4. Click Add to confirm and save your data.

https://www.medicaldirector.com/help/index.htm#t=topics-clinical%2FCervical_Screening.htm
https://www.medicaldirector.com/help/topics-clinical/Cervical_Screening_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
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Recording Cervical Screening via the Holding File

4. Then, select File > Add Cervical Screening Result. 
The Record Cervical Screening Result window appears.
o Enter the date on which the screen was obtained from the 
patient.

o Select a result type from the list provided.

o Tick check boxes as appropriate to indicate whether 
Endocervical cells and/or H.P.V. changes were present.

o If you wish to generate a Recall notification for this patient, 
click Add Recall

5. Click Add to confirm and save your data. The result is added to 
the Cervical Screening tab of the patient's record.

1. Select Correspondence > Check Holding File to open the Holding File.

2. From this window select which recipient will request the Cervical Screening.

3. Once within the Holding File, locate and select the patient for whom you wish to manually 
record a cervical screening.

https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Cervical_Screening_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Holding_File.htm
https://www.medicaldirector.com/help/topics-clinical/Cervical_Screening.htm
https://www.medicaldirector.com/help/topics-clinical/Filtering_Results_in_the_Holding_File.htm
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Recording Cervical Screening via the Clinical Front Screen
1. From the Clinical Front Screen, select Clinical 
> Cervical Screen Results > Add Result. The Select Patient from 
List window appears.

2. Search for and open the patient record you want to add a 
result for. The Cervical Screening Result summary for the patient 
will appear.

o Only female or gender-neutral patients will appear in the list.

3. Click Add The Record Cervical Screening Result window 
appears.
o Enter the date on which the screen was obtained from the 

patient.
o Select a result type from the list provided.

o Tick check boxes as appropriate to indicate whether 
Endocervical cells and/or H.P.V. changes were present.

o If you wish to generate a Recall notification for this patient, 
click Add Recall

4. Click Add to confirm and save your data.

https://www.medicaldirector.com/help/topics-clinical/Opening_a_Patient_Record.htm
https://www.medicaldirector.com/help/topics-clinical/Pt_Details_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
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National Cancer Screening Register

This enables the user to:

•Open the patient’s record and view their test results, summary of the outcome and screening histories;
•View the patient’s screening status and alerts;
•View the patient’s next screening eligible date;
•Generate cervical screening history report;
•Submit Program forms to the Register – cervical and bowel screening program forms;
•View and update the patient’s demographic details;
•Manage the patient’s screening participation, including opting out, resuming participation or deferring from either the 
bowel or cervical screening programs;
•Cease the patient’s correspondence for the cervical screening program; and
•Nominate other people to assist your patient (such as a personal representative or another Healthcare Provider).
For further assistance, you can call the contact centre on 1800 627 701. The contact centre operates Monday to Friday, 
between 8am and 6pm in all Australian state and territory time zones.

The National Cancer Screening Register enables a single electronic record for each person in Australia participating in cervical and 
bowel screening. The National Cancer Screening Register plays a vital role in supporting the National Cervical Screening Program 
(NCSP) and the National Bowel Cancer Screening Program (NBCSP). It gives healthcare providers access to their patients’ health 
information and makes it easier for program participants to take control of their health.

Healthcare providers that have integrated their Clinical Information System with the National Cancer Screening Register, are able to 
interact directly with the National Cancer Screening Register from their existing software using the NCSR widget.
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National Cancer Screening Register – Bowel & Cervical Screening

1. For registered 
patients, the widget 
appears as follows 
with the NCSR 
History tab 
presented by 
default. This tab 
contains the 
patient's history of 
screening results 
retained within the 
National Cancer 
Screening Register.

2. Switch to 
the Choose Form & 
Report tab to 
select a 
form/report to 
submit.
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National Cancer Screening Register – Bowel & Cervical Screening

3. Complete and submit the form.
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Managing Recalls – Sample workflow by Katrina Otto

A Recall is a patient's reminder notice to inform the 
patient that they are due to return to the Practice 
(usually so that some clinical procedure can be 
performed).

The Search Recalls module allows you to;

o Determine which patients are to be recalled i.e. 
those with current Recalls.
o Indicate that the results should include 
completed and/or deleted Recalls.
o Determine which patients you have already 
attempted to contact regarding their Recall(s).
o Record notes against Recalls. See Recall 
Actions for more information about these notes.
o Save your favourite Recall notification search 
lists.
o Print labels or conduct a mail merge for 
contacting patients.
o Send e-mail Recall notifications.
o Send SMS Recall notifications.
o Mark recalls as being completed, and optionally 
update recurring recalls.

https://trainitmedical.com.au/resources-and-support/md-ps-free-templates/
https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Actions_Recall.htm
https://www.medicaldirector.com/help/topics-clinical/Actions_Recall.htm
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Managing Recalls – via the Search > Recall window

A Recall is a patient's reminder notice to inform the patient that 
they are due to return to the Practice (usually so that some 
clinical procedure can be performed).

The Search Recalls module allows you to;

o Determine which patients are to be recalled i.e. those with 
current Recalls.
o Indicate that the results should include completed and/or 
deleted Recalls.
o Determine which patients you have already attempted to 
contact regarding their Recall(s).
o Record notes against Recalls. See Recall Actions for more 
information about these notes.
o Save your favourite Recall notification search lists.
o Print labels or conduct a mail merge for contacting patients.
o Send e-mail Recall notifications.
o Send SMS Recall notifications.
o Mark recalls as being completed, and optionally update 

recurring recalls.

https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Actions_Recall.htm
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Managing Recalls - via the Search > Recalls window

Show only reasons from 
active recalls

Tick this check box to filter the Recall Reasons list to display only reasons associated 
with active recalls. An 'active' recall is one that is neither completed, nor deleted.

Note that enabling this check box has no impact on the search results themselves, but is 
provided here only for the convenience of filtering the selection list.

Attempted to contact 
patient at least...

When recording an Action against a Recall, you can indicate that the Action was an attempt to 
contact the patient about their Recall. You can instruct the Recall search module to show only 
those Recalls where [x] attempts to contact the patient have been made.

Only show patients that 
have attended...

For use at sites that run MedicalDirector Pracsoft in conjunction with Clinical.

MedicalDirector Pracsoft provides a facility for indicating that a patient is returning to your 
practice in response to a specific Recall. By ticking this associated check box, you can instruct 
the Recall search module to show only those patients that have been flagged in this way.

Date Range Allows you to specify when the recalls are due. Note that this date is not when the Recalls 
were created.

Saved Searches Your search criteria can be saved. See Saving Recall Searches for more information.

Include Inactive Patients Allows you to search for patients flagged as inactive.

Conducting a Search for Recalls

1. From the Clinical main screen, 
select Search > Recall.

2. MedicalDirector Clinical's list 
of Recalls opens, and you are automatically 
prompted to select criteria for conducting a 
search of upcoming recalls, using the Recall 
Search Criteria window. See the table below 
for information on key features of this 
window.

3. Enter the criteria you wish to search for. 
Click Search button when you are ready to 
conduct the search.

4. The Search Recalls list becomes populated 
with your search results. Consult the table 
below for features of this window.

https://www.medicaldirector.com/help/topics-clinical/Actions_Recall.htm
https://www.medicaldirector.com/help/topics-clinical/Saving_Recall_Searches.htm
https://www.medicaldirector.com/help/topics-clinical/Inactive_Deceased_or_Deleted_Patients.htm
https://www.medicaldirector.com/help/topics-clinical/Recalls_Searches_and_Notifications.htm?rhsyns=%20#Table1
https://www.medicaldirector.com/help/topics-clinical/Recalls_Searches_and_Notifications.htm?rhsyns=%20#Table1
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Managing Recalls - via the Search > Recalls window > Upper Section
Upper Section

The upper section of this widow displays all the Recalls that match your search criteria.

•Black entries are active (current) Recalls

•Grey entries are deleted Recalls

•Blue entries are completed Recalls

Select All / Select None A toggle button for selecting all records, or none.

Search Click to call the search criteria window.

Search > Save Current Search Criteria

Allows you to save the criteria used to conduct the search. You will be prompted to name 
the search. Afterwards, this search will be available from the 'Saved Searches' section of 
the Recall Search Criteria window. See Saving Recall Searches for more information.

Refresh Refreshes the window with the latest data.

Add Recall
Select a patient from the list of search results, and then click this button to record a new 
Recall for the patient.

Add Recall > Delete Recall Deletes the selected Recall.

Open Patient Opens the record of the selected patient.

https://www.medicaldirector.com/help/topics-clinical/Saving_Recall_Searches.htm
https://www.medicaldirector.com/help/topics-clinical/Adding_and_Editing_Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Adding_and_Editing_Recalls.htm
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Export Allows you to export the list of search results.

Mail Merge

Allows you to bulk-print a letter for the selected records. See also Labels.

After conducting a mail merge, you will be prompted to update (complete) the recalls.

Mail Merge > Print Labels

Allows you to bulk-print address labels for the selected records. See also Labels.

Managing Recalls - via the Search > Recalls window > Upper Section

https://www.medicaldirector.com/help/topics-clinical/Mail_Merge.htm
https://www.medicaldirector.com/help/topics-clinical/Labels.htm
https://www.medicaldirector.com/help/topics-clinical/Completing_Updating_Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Labels.htm
https://www.medicaldirector.com/help/topics-clinical/Labels.htm
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Print List

Prints the list of selected recalls to the printer you have selected as your Letter Writer 
printer. After printing the list, you will be prompted to update (complete) the recalls.

Print List > Print List To
Print the list of selected recalls (allows you to select a printer first). After printing the list, 
you will be prompted to update (complete) the recalls.

Update Allows you to update (mark as 'complete) any selected recalls. See Completing 
(Updating) Recalls.

Send SMS

Allows you to send an SMS reminder to the selected patients, regarding their selected 
Recalls i.e. if a given patient has three Recalls upcoming, they will receive three SMS 
messages - one for each Recall. SMS messages sent from the Search Recalls window 
will use the 'Recall' SMS template.

After sending an SMS, you will be prompted to update (complete) the recalls.

Clear Filters
Clears all filters you have applied to the search results. If you wish to clear an individual 
filter, click the Remove Filter button, located within each filter window (accessed by 
clicking        ).

Reset Window Settings Resets the layout of this window to its defaults.

Managing Recalls - via the Search > Recalls window > Upper Section

https://www.medicaldirector.com/help/topics-clinical/Printer_Setup_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Printer_Setup_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Completing_Updating_Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Completing_Updating_Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Completing_Updating_Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Completing_Updating_Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Sending_SMS_Reminders.htm
https://www.medicaldirector.com/help/topics-clinical/SMS_Reminder_Templates.htm
https://www.medicaldirector.com/help/topics-clinical/Completing_Updating_Recalls.htm
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Lower Section

The lower section (known as the Actions Pane) is split into two panels;

•The lower left-hand panel lists all the Actions taken upon the Recall selected in the upper section. In the example above we have selected a Recall for Carolina Schein in the 
upper section, and in the Actions Pane we can see the three Actions that have been performed against that particular Recall.

•The lower right-hand panel (known as the Details Panel) displays the basic demographics of the selected patient.

Action Taken Displays the type of Action recorded against the Recall selected in the search results.

Date Performed The date on which the associated Action was recorded.
Performed By The user that recorded the associated Action.
Contact Attempt

Whether the selected action was an attempt to contact the patient.

Comments
Any comments recorded against the Action performed. Comments can be made about 
a Recall Action at the time you add one.

Date Deleted The date on which a given Action was deleted.
Deleted By The user that deleted the Action.
Print

Prints the Actions performed against a selected Recall to the printer you have selected 
as your Letter Writer printer.

Print > Print To... Prints the Actions performed against a selected Recall. Allows you to select the printer 
to print to.

Managing Recalls - via the Search > Recalls window > Lower Section

https://www.medicaldirector.com/help/topics-clinical/Actions_Recall.htm
https://www.medicaldirector.com/help/topics-clinical/Actions_Recall.htm
https://www.medicaldirector.com/help/topics-clinical/Actions_Recall.htm
https://www.medicaldirector.com/help/topics-clinical/Printer_Setup_Options.htm
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Managing Recalls - via the Search > Recalls window > Lower Section

Add

Allows you to record a new Recall Action for the selected Recall.

Edit Allows you to edit a selected Action.

Delete
Deletes the selected Action.

Show Deleted / Hide Deleted
A toggle to show/hide deleted actions.

Hide Actions Pane

A toggle button for hiding/showing the Actions Pane. This button is only available if the 
lower half of this window is visible. See 'Hide Details' in this table for more information.

Hide Details Panel

A toggle button for hiding/showing the Details Panel located in the right-hand section of 
the Actions Pane.

Close
Closes the Search Recalls module

https://www.medicaldirector.com/help/topics-clinical/Actions_Recall.htm
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Managing Recalls - via the Patient's Record
1. Select Clinical > Recall. The Recall Items window appears.

o The upper section of this window lists the patient's recalls.

o The lower section lists any recalls actions you have recorded against each of the recalls in 
the upper section i.e. each recall can have multiple actions recorded against it.

2. Select one of the available recalls in the upper section to manage actions for.

3. (optional) If the selected recall has had actions applied to it which were subsequently 
deleted, you can reveal these now by clicking the Show Deleted button. If this button is not 
available, it is because there a no deleted actions to reveal.

4. Then to;

o Add a new action, click Add. Continue now to Step 5.

o Edit an existing action, select it from those available, and then click Edit. The Edit Recall 
Action window appears. Continue now to Step 6.

o Delete an existing action, select it from those available, and then click Delete. You will be 
prompted to confirm this. Note that this cannot be reversed.

5. The Add Recall Action window appears.

6. Indicate who performed the Recall Action via the associated drop-down list. Optionally, 
you can elect to include inactive/deleted practitioners/users in this list.

7. Indicate the type of action performed. This list of hard-coded actions includes:

Consultation               Other                 Send Email                   Send Fax                  Send Letter       
Send SMS             Telephone Business                 Telephone Home              Telephone Mobile

8. Enter the date on which the Action was performed.

9. (Optional) Record a comment if desired.

10. (Optional) Indicate whether you also wish this action to be 
recorded as an attempt to contact the patient.

11. Click Save to save the action to the patient's recall item.

https://www.medicaldirector.com/help/topics-clinical/Adding,_Editing_and_Deleting_Practitioners_and_Nurse_Practitioners.htm
https://www.medicaldirector.com/help/topics-clinical/Adding,_Editing_and_Deleting_Users.htm
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About Actions (Recall vs. Outstanding)

Recall Actions

A Recall Action is a note recorded about a Recall that 
typically relates to correspondence / contact regarding a 
Recall.

For example, if you had sent a printed Recall reminder 
letter to a patient, and then followed-up that letter with a 
phone call, you may wish to record the fact that you made 
the phone call. This action can be recorded against the 
Recall within the patient's record. A single Recall can have 
an unlimited number of Recall Actions recorded against it.

A Recall Action is not to be confused with 
an Outstanding Action (see below).

See also Actions (Recall)

Outstanding Actions

An Outstanding Action is a practitioner's reminder 
notice about a specific patient, that appears on-screen 
upon opening their record. You can configure Clinical 
to present you with a pop-up list of Outstanding 
Actions for a specific patient. Alternatively, you can 
view a list of all Outstanding Actions for all patients, 
and then filter that list by practitioner or by type of 
Action.

Outstanding Actions are designed to remind the 
practitioner to perform one or more clinical actions for 
the patient, but can be used to record any reminder 
notice about the patient you desire.

An Outstanding Action is not to be confused with 
a Recall Action (see above).

See also Adding Outstanding Actions

https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
https://www.medicaldirector.com/help/topics-clinical/Actions_Recall.htm
https://www.medicaldirector.com/help/topics-clinical/Outstanding_Actions.htm
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Generating a Recall in Insights

The following steps show how you might 
generate a recall for patients. In this example 
we are going to generate a recall for an 
Asthma Review for those patients who have 
an active condition of Asthma.

1. Select Conditions > Respiratory 
Prevalence.

2. In our example, we want to see only 
those patients with an active condition of 
'Asthma', so we select (click) the associate 
column in the visualisation.

o When you select one or more regions in 
this way, your selection is shown at left (i.e. 
"1 region selected), and you are presented 
with a View button The list of associated 
patients appears.
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Generating a Recall in Insights

Note also that you can access such lists of patients via the supplied Reports:

4. Click Add Recall button You are presented with the Recall details for you to 
configure.

o Indicate the Practitioner the Recall is being created on behalf of.

o Indicate the reason for the Recall. In our example, we have selected 'Asthma 
Review'. If you select a reason from the list, its schedule settings are loaded for 
you automatically. You can modify these if you wish, and such modifications will 
not affect the reason definition, nor will they affect any Recalls already saved.

o Indicate whether this is a once-only Recall, or a recurring Recall. For recurring 
Recalls, you must also indicate the interval between Recall visits.

• For once-off Recalls, this is the date on which you wish the patient to return 
to the practice.

• For recurring recalls, this is the date on which you wish the first return visit to 
occur.

o Indicate the Recall due date.

5. Click Add Recall button. You will be prompted to confirm this action.

6. Click Yes button to confirm. The recalls are added to Clinical. See Recalls for 
detailed information.

https://www.medicaldirector.com/help/topics-insights/insights_reports.htm
https://www.medicaldirector.com/help/topics-clinical/Recalls.htm
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Recall & Reminders via Smart Marketplace Partner – AutoMed Systems 

AutoMed Clinical Reminder Service (Recalls) 

AutoMed can create a Rule per Reminder Reason.

Optionally add a catch all Rule that will send for ALL Reminder Reasons, 
including new ones going forward – Nothing Gets Missed.

The doctor adds the recall to the patients file with the Reason and Due 
Date

AutoMed automatically sends patients an SMS, a set number of days 
before it is due. 

Select whether to send plain or secure SMS and enter a specific message 
per reminder type.

Choose which reminders should send, when they should be sent and 
what they should say.

Set it up once and it runs automatically, no manual allocation of 
templates required.

Automatic 2nd Discuss SMS if patient has not booked an appointment 
within the required number of days.

Automatically creates mail merges, with bulk export function, for 
patients who can’t be contacted by SMS, Opted Out, or have not 

attended after all contact attempts. 

Optional ad-hoc 3rd SMS or restart Message Cycle per recall.

All contact attempts and correspondence saved to the patient’s record.

AutoMed provides one on one Online Staff Training sessions using 
Clinics own data. 

An Advanced Reporting feature provides real-time interactive snapshots, 
directly from PracSoft  of all Recalls & Results, their status, contact 

attempts, Assoc practitioners and contact notes.                                                                             

AutoMed Services Overview 

BENEFITS

Save time, and money outbound call costs and create revenue from 
Recall appointments.

AutoMed Recalls ensures that you contact all patients for upcoming 
reminders with specific content and rules t match, keeping your practice 
complaint and accreditation ready.                                                                                           

AutoMed%20Services%20Overview


TELSTRA HEALTH INTERNAL

Recall & Reminders via Smart Marketplace Partner – Automed Systems 
AutoMed Results Service (Callbacks)  

AutoMed’s unique, sophisticated results messaging system 
automatically sends specified messages to your patients when 

the practitioners have reviewed correspondence or investigations 
and marked them as No Action, Discuss or Urgent Appointment

Messaging runs every hour during business hours.

Configurations available to include / exclude certain action types.

Ultimately the system aims to send a single message to the 
patient, for the highest assigned action, for a batch of results.

If your preference is that the patient receive individual messages 
per pathology or radiology provider, this can be configured.

SMS can be set to insert the Doctors Comment associated with 
the Result to personalise the communication.

Automatic 2nd message if patient has not booked an appointment 
within the required number of days.

Automatically creates mail merges, with bulk export function, for 
patients who can’t be contacted by SMS or have not attended 

after all contact attempts.

Comprehensive message logs All contact attempts and 
correspondence saved to patient’s record.

The Advanced Reporting feature within AutoMed provides a real-
time snapshot of all results, their current status, as well as past 

and upcoming appointments to provide the most comprehensive 
display of data integrated between AMS and PracSoft.

AutoMed Services Brochure

BENEFITS

Save Staff time and costs by                                                                                                 
reducing calls to reception                                                                                                  
regarding Results by up to 95%                                                                                               
by keeping your patients                                                                                                     
informed as to their results and                                                                                            
the action required.
AutoMed delivers and receives                                                                                                 
all SMS’ via a Tier 1 Enterprise                                                                                             
Message Gateway
Unlimited SMS
160 -900 characters if required.

https://automedsystems-syd.com.au/training/AutoMedServices.pdf
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Automate your clinical reminders and recalls with ease
Free up valuable time across your team with quick, easy and automated patient recalls 
via SMS, letters or phone calls. The choice is yours. Experience the convenience of 
Healthengine's new and improved Recalls, tailor-made to elevate your practice efficiency.

Recalls for your practice, your way
Healthengine’s Recalls puts the control in your hands for both clinical reminders and recalls. 
Easily set your parameters based on the needs of your patients and your own practice 
preferences. Choose your sequencing (e.g. two SMS sends, followed by a letter), the type of 
recall or clinical reminder (e.g. urgent result), specify your contact timeframes and away you 
go.

Reduced workload, reduced expenses
Recalls is a flexible solution, tailor made and setup for each individual practice on 
Healthengine. This allows you to choose the level of automation versus manual input, letting 
your team rapidly process recalls and clinical reminders at both pace and scale. Now you can 
give valuable time back to your team, allowing you to focus on providing an exceptional 
experience for patients.

Recall & Reminders via Smart Marketplace Partner - Healthengine

Patient Recalls & Clinical Reminders 
with Healthengine 

Recalls experience in action practice efficiency.

The benefits of Recalls with Healthengine:
• Unlimited SMS recalls and clinical reminders included for practices onGP Complete
• Free up staff time across the team by automating your recalls and clinical reminders process
• Choose, customise and edit your level of automation versus manual input
• Set your own parameters for clinical reminders, urgent and non-urgent recalls
• Choose how and when recalls and clinical reminders are sent (via SMS, letter, phone call)
• Save costs on printing and stationery with our SMS and phone call recall options
• Secure three-step ID verification for patients when receiving recalls
• Audit notes are logged automatically in your PMS for a complete audit history

What's new for Recalls

•  PMS locations can be viewed for 
each patient recall

•  Add patients to your block list for 
SMS messages

•  We’ve reduced unnecessary notes 
sent to your PMS

https://practices.healthengine.com.au/optimise-your-booking/healthengine-recalls-2/
https://practices.healthengine.com.au/optimise-your-booking/healthengine-recalls-2/
https://youtu.be/q3r4cC1ci4c
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Recall & Reminders via Smart Marketplace Partner - HotDoc

HotDoc Clinical Reminders (Recalls)
HotDoc Recalls is a system that handles both Results and 
Clinical Reminders and allows you to securely send SMN 
messages and push notifications to patients if they have an 
upcoming recall in their patient file.

How does it work?
1.
A doctor adds a recall into a patient's record, this is usually 
entered with a recall reason and a due date.
2.If the recall is unresolved and has a due date within the 
syncing window HotDoc will bring it into the dashboard.
3.Once HotDoc has synced a clinical reminder into the 
Dashboard, it will automatically send out a push notification or 
SMN depending on whether the recall has been attached to an 
applicable template.

Want to learn more?

Demo with HotDoc
HotDoc Clinics Reminders overview
How to set up recalls and clinical reminders

PLUS

HotDoc users get access to the online Academy Training platform and 
regular Live Training Sessions to learn or refresh their recalls knowledge.

HotDoc syncs and displays the following as part of the recall:

•Patient name
•Recall Reason (as outlined in the patient record)
•Due date
•Mobile number
•Date of Birth
•Doctor performed (if linked correctly)
•Patient's next appointment date

https://cdsqz04.na1.hs-sales-engage.com/Ctc/Q+23284/cdsqZ04/Jl22-6qcW7lCdLW6lZ3mdW4ZxH4N8F7bfYW67jByr4n4TXBW8zGnkQ2KKMSVW8Ym0qW3QTZsTW8VJQR48Q_376W5VrdHJ97w8S9W10fmZv12CLhnW80d8m87jj-sHVfsMTH70Y2npW4BV8Xg29TmymW25CgVT7qC6XPW3rNbPR7xJBNhW8B0j5V4Yv2c3N8kgc4hznJZmW6H16j47H2LYRW1r0L7t2hzC6PVvXxzY40sfw-W1KMP6M16yB66W4DZx7l9fxyJLW43LvH678VxzMW5V0Lj12Y9SJHW2Rp1cw2LtWGZW8X3k0k6LQKCKV2fRLd7hdLSmf3JT_pz04
https://cdsqz04.na1.hs-sales-engage.com/Ctc/Q+23284/cdsqZ04/JkM2-6qcW6N1vHY6lZ3mDW81SFzc19s1bcW8jH5yV4ZJ14KW6qQMqn6n5N3fVKdL243Kn941W89xKRN6Wj8KTVM5-_D45PhBxW76sjmj2WxjzgW2pJ3x52J03dFW1_tt7Z852VlMW2Vhzdn838PyJW5qGC9T24w6yHVDXnQr5hYNlMW3_2QMf1vcV1kW29Fnd13KF8vjVXNTMF1XSFxvW5h1LPy5mh43sN68mLYXy2bqrW5b8BYl2W1blbW6PHpL58JbMpJW5sgNLP2Jx0tbW7CcgGb8-H2p0W8HkT0799G1CQf4nms0s04
https://cdsqz04.na1.hs-sales-engage.com/Ctc/Q+23284/cdsqZ04/JlY2-6qcW95jsWP6lZ3n-W6q9JSQ1L6_hdW2bY5VS1p0jwwVLCJmY5Vv6cDN3hzxgFZ2wz4N21q6kpnBg2-W2dx6Jh6T4PYrW8yLFc53FHJ-tW9fKy_d6Bc3P5W5Ft1r12Mfl7LW59pvjq2pJP-rW7q4vSW1pgc3zW6sJp0B7PJP5TVLC9wp2ynjj6VhDP4K3mHXTPW7by92k1RdmyCW1l8_Fz31MlG_W2wgPNn4XpCLKW2K03wk6WVs3yW93N-Vr1hQ0fnW2G57QP63KgVHW7Fzvth6Slc3KW4yt8md1_wwQQW6lKZRm7m1yJVW6DvHsB3zfnMzW887fFZ8JYqNDW7sLBj27fnRNPV46QK25bBrLSW7X4s7C3bpPDbW3RqrQw3sS5JQW1pcx9k4QZZGLf6yVpnx04
https://academy.hotdoc.com.au/page/recalls-gp
https://try.hotdoc.com.au/live-training-sessions
https://support.hotdoc.com.au/hc/en-gb/articles/360029241912
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Recording Social and Family History

Data recorded here is available to the Letter Writer where it 
can be merged into letters and e-mail correspondence. Family 
History and Social History data will also appear on 
the Summary tab.

Item Criteria

ADF Service Indicate the patient's service (if any) with the Australian Defence Force.

A patient's service status;

•Is displayed within the Occupation field located towards the top of 
the Clinical Window.

•May affect whether you are prompted to perform an assessment for 
them upon opening their clinical record.

Update Address 
for All Family 
Members check 
box

Update the address details for other family members, with the details 
of the current patient. Clinical uses the Head of Family. setting to 
determine which patients are members of the same family. This option 
is only available when editing Patient Details from the Clinical Window.

Auto-Capitalise 
Names check 
box

Tick the Auto-Capitalise Names check box to automatically capitalise 
the first letter of each word you type. There are numerous windows 
throughout MedicalDirector Clinical that offer this functionality, 
including the various Options tabs.

https://www.medicaldirector.com/help/topics-clinical/Summary_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Prompt_Preventive_Health_Criteria.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Options.htm
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Recording Alcohol
The AUDIT-C assessment can help identify persons who are hazardous drinkers or have active alcohol use 
disorders (including alcohol abuse or dependence). The AUDIT-C is a modified version of the 10-question 
AUDIT instrument. The AUDIT-C is scored on a scale of 0–12. Each AUDIT-C question has five answer choices. 
Points allocated are:

a = 0 points           b = 1 point            c = 2 points              d = 3 points           e = 4 points

o In men a score of 4 or more is considered positive, optimal for identifying hazardous drinking or active 
alcohol use disorders.

o In women a score of 3 or more is considered positive (same as above).

The recording of data on this tab is for your records only; it plays no part in the functioning of other modules 
within Clinical, except for the Letter Writer where some of this information can be merged into letters.

•Click View Alcohol Guidelines to open a window of information on alcohol consumption.
•Click Reference to open the World Health Organisation's web page 'Screening and brief intervention for 
alcohol problems in primary health care'.
•Click New Assessment to record a new assessment. This clears data from the window, ready for your new 
assessment. Once you completed the assessment, click Save to save the data. A new entry will be added to 
the list of assessments, located at the top-right of this window.

• A note is also added to the patient's Progress Notes.
• Information you save here is reflected in the patient's Health Assessment, and ATSI Health 

Assessment (for eligible patients).
• The latest assessment is always displayed by default when you access the Alcohol tab.

•To view a previous assessment, locate and double-click a previous assessment from the list at the top-right 
of this window.
•Click Delete to delete a previous assessment.
•Update Address for All Family Members check box: Update the address details for other family members 
with the details of the current patient. Clinical uses the Head of Family setting to determine which patients 
are members of the same family. This option is only available when editing Patient Details from the Clinical 
Window.
•Auto-Capitalise Names check box:Tick the Auto-Capitalise Names check box to automatically capitalise the 
first letter of each word you type. There are numerous windows throughout MedicalDirector Clinical that 
offer this functionality, including the various Options tabs.

https://www.medicaldirector.com/help/topics-clinical/Letter_Writer.htm
https://www.medicaldirector.com/help/topics-clinical/Alcohol_Tab.htm#Alcohol_Guidelines
http://www.who.int/substance_abuse/activities/sbi/en/
http://www.who.int/substance_abuse/activities/sbi/en/
https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Health_Assessment.htm
https://www.medicaldirector.com/help/topics-clinical/Aboriginal_and_Torres_Strait_Islander_ATSI_Health_Assessment.htm
https://www.medicaldirector.com/help/topics-clinical/Aboriginal_and_Torres_Strait_Islander_ATSI_Health_Assessment.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Options.htm
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Recording Smoking

The recording of data on this tab is for your records only; it plays no part in 
the functioning of other modules within Clinical, apart from the Letter 
Writer where this information can be merged into letters.
Click View Patient Education Leaflet to open a pre-selected PDF leaflet 
entitled 'Smoking - Quitting'. This leaflet is one of many Patient 
Education leaflets available.

Smoking cessation intervention discussed with patient check box: Ticking 
this box flags patients for the Smoking Cessation report found in 
MedicalDirector Insights.

Update Address for All Family Members check box: Update the address 
details for other family members, with the details of the current patient. 
Clinical uses the Head of Family. setting to determine which patients are 
members of the same family. This option is only available when editing 
Patient Details from the Clinical Window.

Tick the Auto-Capitalise Names check box to automatically capitalise the 
first letter of each word you type. There are numerous windows throughout 
MedicalDirector Clinical that offer this functionality, including the 
various Options tabs.

https://www.medicaldirector.com/help/topics-clinical/Letter_Writer.htm
https://www.medicaldirector.com/help/topics-clinical/Letter_Writer.htm
https://www.medicaldirector.com/help/topics-clinical/Patient_Education_Leaflets.htm
https://www.medicaldirector.com/help/topics-clinical/Patient_Education_Leaflets.htm
http://test.medicaldirector.com/help/insights/about_insights.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Options.htm
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Keeping Past History items relevant

The Past History tab displays a summary of the 
patient's medical history. This is not to be confused with 
a patient's clinical progress, as recorded via Progress 
Notes.
Coded: Indicates if the diagnosis was made by selecting 
from the DOCLE list of diagnosis.

Comment: Displays comments relating to a given past 
history entry. This window is read-only.

Types of History Records: Filter the past history records 
by All Records, Active, Inactive (displayed in grey), or 
Summary

No Significant Past History: If the patient has no 
significant clinical history to make a note of, indicate this 
by ticking this check box. A prompt to remind you to 
check this status with your patient is managed from 
within Prompt/Preventive Health Options. To view a 
percentage of patients who have not been asked about 
their past history status, see Clinical Data Statistics. You 
can also print a list of patients from this search utility.

When viewing all records, inactive items are displayed in grey.

https://www.medicaldirector.com/help/topics-clinical/Adding,_Editing,_and_Deleting_History_Items.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Notes.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Progress_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Prompt_Preventive_Health_Options.htm
https://www.medicaldirector.com/help/topics-clinical/Patients_with_Non-Entered_Clinical_Data.htm
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Creating letters 
Letters are created and edited with the Letter Writer.

1. Open the Letter Writer by either:

o Selecting Tools > Letter Writer from the Clinical front screen,

o Pressing F8,

o Clicking          on the tool bar within the patient's Clinical Window,

o Selecting the Letters tab within the patient's Clinical Window, and clicking the      
button,

o Selecting the Letters tab within the patient's Clinical Window and clicking Add.

o Selecting the Correspondence tab within the patient's Clinical Window, 
clicking Add, and selecting Letter from the menu that appears..

2. Within Letter Writer, to create a new letter either;

o Click        on the tool bar, or

o Select File > New, or

o Press CTRL+N

3. The New window appears.

4. Double-click the template you wish to base the new letter on, or create a new 
template by selecting Blank Template. Alternatively you can search for a template 
using the box provided. 

See Letter Writer for more information about creating and editing letters.

https://www.medicaldirector.com/help/index.htm#t=topics-clinical%2FCreating_and_Editing_Letters.htm
https://www.medicaldirector.com/help/topics-clinical/Letter_Writer.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Letters_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Letters_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Correspondence_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/Templates.htm
https://www.medicaldirector.com/help/topics-clinical/Creating_and_Modifying_Templates.htm
https://www.medicaldirector.com/help/topics-clinical/Creating_and_Modifying_Templates.htm
https://www.medicaldirector.com/help/topics-clinical/Letter_Writer.htm
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Auto Text – Adding Signature

1. From within Letter Writer, either;

o Select Edit > Auto Text
o Press Ctrl+T

2. The Auto Text window appears.

3. From here you can;

o Add a new Auto Text entry (eg 
\SIGN)
o Change an existing Auto Text entry 
(see below for detailed information)
o Delete an existing Auto Text entry, 
by selecting it in the Shortcut window 
and clicking Delete button.
o Insert an existing Auto Text entry, by 
selecting it in the Shortcut window and 
clicking Insert button or a Picture of 
your signature by pasting and edit size.

Auto Text functionality allows you to 
quickly insert bodies of text into a letter 
using a single keyword or phrase. For 
example, instead of having to 
repeatedly type your entire salutation 
every time you create a new letter, you 
can program Letter Writer to insert it 
automatically upon typing a single 
keyword or phrase, such as 
'mysalutation'.

There is no limit to the number of Auto 
Text entries, or the length of each entry 
that can be stored in Letter Writer, and 
you can share the Auto Text entries you 
create with other users.

o Managing Auto Text

o Creating and Editing Auto Text

https://www.medicaldirector.com/help/index.htm#t=topics-clinical%2FAuto_Text.htm
https://www.medicaldirector.com/help/topics-clinical/Auto_Text.htm#Managing_Auto_Text
https://www.medicaldirector.com/help/topics-clinical/Auto_Text.htm#Creating_and_Editing_Auto_Text
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Auto Text – Adding Signature

The following example shows how you can also insert 
Auto Text into your document by typing the keyword 
shortcut associated with that Auto text entry.

This example uses a keyword shortcut of \SIGN. Upon 
typing this keyword, Letter Writer would detect that 
the text you typed may relate to one of the Auto Text 
entries you have created, and display a pop-up 
window containing the associated Auto Text. If you 
wanted to add the Auto Text to your document, you 
would simply press the Enter key on your keyboard, 
and the Auto Text would be added to the page 
automatically, as shown below.
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Removes a selected document from the My Health Record system. This is only available if you are the 
creator of the original document, or it was created by another user from the same Practice (i.e. with 
the same Practice HPI-O recorded via Tools > Options > Practice tab.

My Health Record Accessing
With Clinical configured correctly, you can access a patient's My Health Record 
documentation via the My Health Record menu within the patient's Clinical 
Window. You will be presented with the My Health Record window, an example 
of which is shown below.

Note that when you first access the My Health Record system, you will be 
prompted to complete your user name details. You will only be asked this once.

Allows you to gain access to documents that have been password-protected by 
the patient - it is the patient who controls access to their My Health Record 
documentation.

Any document can be applied one of two access levels;

•Open: the document is unrestricted.

•Code: the document requires an access code to view/download.

Click the Change/Gain Access button, and then select from the three Access 
Type options;

•Open Access: no access code required.

•Access Code: enables the Access Code field in which you must enter the access 
code the patient provided you.

•Emergency: grants you access to password-restricted documents for five days. 
To be used in an emergency when the patient cannot be contacted. A record of 
the document being accessed in this fashion may be sent to the patient.

https://www.medicaldirector.com/help/topics-clinical/Practice_Options.htm
https://www.medicaldirector.com/help/#rhsearch=my%20health%20record%20accessing%20prescription%20&rhhlterm=my%20health%20record%20accessing%20prescription%20&rhsyns=%20&t=topics-clinical%2FMyHealthRecord.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
https://www.medicaldirector.com/help/topics-clinical/The_Clinical_Window.htm
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My Health Record accessing Prescription & Dispense 

The Prescription and Dispense View tab 
lists prescribed/dispensed medications 
that the patient has granted consent to 
upload to the My Health Record System. 
Consent is typically indicated via the 
Enter Dose window during 
the prescribing process, but can also be 
granted/revoked afterwards by right-
clicking an item on the CurrentRx tab and 
clicking the My Health Record Consent 
entry from the menu that appears. This 
functionality requires that you have 
enable ePrescribing.

To view a medication on this window;

1. First, expand the medication details 
by clicking the   button at the far left 
end of the medication row.

2. Secondly, click the medication 
details. The script details will be revealed

https://www.medicaldirector.com/help/topics-clinical/Creating_New_Prescriptions.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/ePrescribing_Configuration.htm
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My Health Record accessing Pathology Report
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My Health Record accessing Diagnostic Imaging Report
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My Health Record uploading while Prescribing

With a patient’s consent, prescriptions can be uploaded to their My Health 
Record. The upload occurs automatically when you print a script. Consent is 
typically indicated via the Enter Dose window during the prescribing process, 
but can also be granted/revoked afterwards by right-clicking an item on 
the CurrentRx tab and clicking the My Health Record Consent entry from the 
menu that appears.

The National Prescription and Dispense Repository (NPDR) is a subset of a 
patient’s My Health Record and allows for the creation of an online medication 
history (for both prescriptions and dispensing). Transfer of medications in this 
way requires you are registered for ePrescribing and have enabled eRx Script 
Exchange.

Prerequisites:
o Practitioner is registered for ePrescribing. See ePrescribing 
Configuration for instructions.

o My Health Record is configured correctly. See Configuring 
MedicalDirector Clinical for My Health Record for instructions.

o Practitioner has indicated their participation in My Health 
Record. See below for details.

For further information regarding the NPDR, please refer to the following link:

www.ehealth.gov.au/internet/ehealth/publishing.nsf/Content/faqs-hcp-
managing#anchor11

https://www.medicaldirector.com/help/topics-clinical/Creating_New_Prescriptions.htm
https://www.medicaldirector.com/help/topics-clinical/Current_Rx_(Medications)_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/ePrescribing_Configuration.htm
https://www.medicaldirector.com/help/topics-clinical/ePrescribing_Configuration.htm
https://www.medicaldirector.com/help/topics-clinical/MyHealthRecord.htm#Configuring_Medical_Director_for_PCEHR
http://www.ehealth.gov.au/internet/ehealth/publishing.nsf/Content/faqs-hcp-managing#anchor11
http://www.ehealth.gov.au/internet/ehealth/publishing.nsf/Content/faqs-hcp-managing#anchor11
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My Health Record uploading Documents

1. Create a CDA document via one of the supplied 
e-Health templates in Letter Writer.

2. Then, within the patient's record, locate the 
document you wish to upload. Documents can 
reside on either of 
the Correspondence, Documents, Results or Letters
tabs.

3. Click Send To MyHealthRecord button.  You will 
be presented with a preview of the document.

4. If you are satisfied that this is the document you 
wish to upload, click Send on the preview window.

5. The upload will commence and you will be 
notified upon completion. The 'My Health Record 
Status' and 'My Health Record Activity Date' 
columns within the correspondence tabs of the 
patient's record will indicate the selected 
document's My Health Record status.

https://www.medicaldirector.com/help/topics-clinical/Creating_CDA_e-Health_Documents.htm
https://www.medicaldirector.com/help/topics-clinical/Letter_Writer.htm
https://www.medicaldirector.com/help/topics-clinical/Correspondence_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Documents_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Results_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Letters_Tab.htm
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My Health Record Saving, Superseded or Removed

1. Within the patient's record, select the My Health Record 
menu. You will be presented with the My Health Record 
window.

2. Locate and select the document you wish to download.

3. Click Save in MD button. 

o If the document is of type 'Shared Health Summary' or 
'Event Summary' it is saved to the Documents tab of the 
patient record. Documents of type 'e-Referral' or 'Specialist 
Letter' are saved to the Letters tab.

o If the document already exists in the patient's record (it 
has already been downloaded from My Health Record), you 
will be notified accordingly.

o If the document already exists in the patient's record, but 
on the My Health Record system there is a newer version of it, 
the document will be downloaded to the patient's record, and 
the older version will be retained within the patient's record 
for historical purposes.

o The 'My Health Record Status' and 'My Health Record 
Activity Date' columns within the Documents/Letters tabs will 
indicate the selected document's My Health Record status, 
such as 'Uploaded', 'Downloaded', 'Superseded', or 'Removed'.

https://www.medicaldirector.com/help/topics-clinical/Documents_Tab.htm
https://www.medicaldirector.com/help/topics-clinical/Letters_Tab.htm
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Introducing Telstra Health Smart Marketplace – a reimagined suite of healthcare 
management tools for General Practitioners and Practice Managers.
This all-inclusive ecosystem empowers medical professionals with a comprehensive 
suite of tools designed to streamline every aspect of their practice.
Manage your practice your way, with tailored solutions from Smart Marketplace. Smart 
Marketplace offers a growing partner ecosystem that enables you to tailor your clinical 
IT systems with innovative solutions suited to the unique needs of your practice. Smart 
Marketplace is comprised of an array of health technology partners who offer the 
highest standard in innovation, service and reliability.
Each Smart Marketplace partner is handpicked for their proven effectiveness and 
innovation.

https://www.telstrahealth.com/products/telstra-health-smart-marketplace/
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MedicalDirector Care – Introducing MedicalDirector Care Plan

Care plans are an important tool to support 
patients with chronic health conditions, but 
they can be complicated and time-
consuming. This webinar shows you how 
MedicalDirector Care is making care plans 
simple and easy to manage while promoting 
compliance with Medicare.
Join this webinar to learn:

•How care plans benefit patients, practitioners 
and practices
•How MedicalDirector Care is taking the 
hassle out of creating, tracking, reviewing and 
updating care plans
•How to use the templates in MedicalDirector 
Care to create powerful care plans that will 
support your patients throughout their 
healthcare journey.
With MedicalDirector Care at your fingertips, 
empowering your patients to live their 
healthiest lives has never been easier. Check 
out our webinar and you’ll soon see why!

https://www.medicaldirector.com/resources/introducing-medicaldirector-care-making-care-plans-easy?submissionGuid=ac4a4d97-a352-43e7-b3a5-e67e463aed7a
https://www.medicaldirector.com/resources/introducing-medicaldirector-care-making-care-plans-easy?submissionGuid=ac4a4d97-a352-43e7-b3a5-e67e463aed7a
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MedicalDirector Care – Setup Care Plans

Before you Begin

o The MedicalDirector Care widget requires MedicalDirector Clinical 3.18 or later.

o You will need to install the MedicalDirector Care Widget. See Managing Widgets for instructions.

o You will need to create and save a default eSignature.

o The MedicalDirector Care widget requires Google Chrome, Microsoft Edge, or Mozilla Firefox

Create an eSignature

•For information about electronic signatures, see Electronic Signatures.
•Note that an electronic signature is only effective if the person receiving it (e.g. 
a specialist) accepts the signature in that form.

1. Open the MedicalDirector Care widget from the Sidebar and select User 
Settings.

2. Locate and click the eSignatures settings button, as shown below.

o If this is the first time you have created an eSignature, the Default 
eSignature Preview window will be blank, as shown in the example.

3. Select either the Upload sSignature tab or the Draw eSignature tab to 
enter a new eSignature.

o The Upload eSignature tab allows you to upload an image of a signature 
that you already have saved on your computer.

o The Draw eSignature tab allows you to create a new eSignature, 
manually, by using your finger or stylus on a touch-screen or tablet.

4. You will be presented with a preview of the eSignature, and prompted to 
use it as the default. Tick the Use as Default eSignature checkbox to confirm.

5. The eSignatures settings window will now display your default selected 
eSignature. This will be used for all future Care Plans created in 
MedicalDirector Care, unless you choose to delete it and create a new one. No 
other configuration is required.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
https://www.medicaldirector.com/help/topics-clinical/Managing_Widgets.htm
https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm?rhhlterm=md%20careplan&rhsyns=%20#Create_an_eSignature
https://www.medicaldirector.com/help/kba/general/Electronic_Signatures.htm
https://www.medicaldirector.com/help/topics-clinical/Sidebar.htm
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MedicalDirector Care – Create a Care Plans
Obtain consent, review the patient’s health 
summary and choose focus areas. Assign 
team members and generate 
documentation.

Overview

1. Obtain the patient’s consent.
2.. Assign the primary GP.
3. Discuss and record the patient’s 
overarching goal.
4. Review the patient’s health summary.
5. Select a template and choose focus 
areas.
6. Customise care plan to suit the 
patient.
7. Set goals, tasks and metrics.
8. Assign team members, generate 
referrals.
9. Set tracking and billing options.
10. Generate a printed care plan.

MedicalDirector Care is able to create 
printed care plans.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create a  Care Plans
Launch a care plan, obtain patient consent and discuss the 
patient’s overarching health goal

1. From within the patient's record, open the MedicalDirector 
Care widget from the Sidebar and choose Create Care Plan.

2. Gain the patient’s consent to create a care plan.

3. Click create button o You may be required to log into the MD 
Care site.

o The Care Plan Setup will commence.

4. You will be presented with the Patient Consent window where 
you can review the conditions of consent.

o This step can be skipped and recorded later in the patient 
dashboard.

5. Click Select Primary GP> button to continue.

o On the Select Primary GP window, accept the default 
healthcare professional selected or choose another.

6. Click the associated Goal button to continue. You are 
presented with an opportunity to record the patient's goal, in their 
words.

7. Click Health Summary > button Review the patient’s health 
summary, select a template and choose focus areas.

o All data appearing in the Health Summary is taken directly 
from MedicalDirector Clinical. As such, MedicalDirector 
Clinical remains the source of truth for the care plan. If data 
needs to be corrected, correct it in Clinical and relaunch the 
care plan. Review Conditions (past medical history), 
Medications, Allergies, Immunisations, Family History and 
Social History. Ensure the data is correct and is suitable for 
sharing with team members outside the practice. Use the check 
boxes to decide what will (and won’t) be shown on the care 
plan.

o The data chosen in the previous screens all make up the 
patient summary part of the care plan, including:

• The patient’s goal.

• Social and family history.

• Patient demographic details.

• Medications.

• Conditions (Past medical history).

8. After navigating the patient's Health Summary and making 
modifications as required, click Plan Details > button to 
choose a plan template that suits this patient.

o The Supplied tab on this window contains supplied 
templates.

o Supplied templates can be modified to suit your practice’s 
needs. Modified templates appear in the Customised tab.

9. Select a plan to customise.
10. Click Create Plan> button to create the care plan.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create a Care Plans

11. You can set goals, tasks and metrics for each focus 
area.

o Health summary pages.

o Focus areas pages.

o Care plan.

o Roles and team members & team member 
documentation.

o Admin tasks (billing and reminders).

o Finalise and generate the care plan document.

o Timeline of all consult notes, correspondence, 
pathology and imaging results for this patient.

o Goal progress.

o Clinical goals for the patient.

o Automatically pre-fills latest metrics and 
measurements retrieved from MedicalDirector Clinical, 
minimising data entry errors.

12. Review and edit patient clinical goals if required.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create a Care Plans

13. Review and edit patient metrics if 
required.

o The metrics are pre-defined as part of a 
template.
o For each metric selected, all available 
measurements will be automatically 
imported from MedicalDirector Clinical.
o Only the most recent measurements are 
shown here. To see older measurements 
click View History.
o To add a new metric, click Add Metric.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create a Care Plans

14. Review and edit tasks if 
required.

o Competed tasks will 
show in the Completed 
view.

o Task descriptions can 
be changed, roles added or 
removed and the duration 
and due dates can be set (if 
required).

o There are two default 
roles; GP and Patient.

o Tasks can be assigned 
more than one role. Assign 
roles to providers in the 
Team Members page.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create a Care Plans
15. Assign team members and generate referrals.

1. Via the Team Members list located in the left-
hand margin of this window, select the type of 
healthcare professional you wish to assign to the 
care plan. In the example below, we have 
selected Physiotherapist.
• The Team Members list is dynamic, based 

on the roles you assigned to the various 
tasks of the care plan.

• The list of available healthcare 
professionals/providers is drawn from the 
MedicalDirector Clinical Address Book.

15b. Click Assign Provider to locate and select a 
healthcare provider of the type you wish to add to your 
team.

• Click Assign button against the provider you 
wish to select.

You will be returned to the Team Members page where 
your selected provider now appears.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
https://www.medicaldirector.com/help/topics-clinical/Address_Book.htm
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MedicalDirector Care – Create a Care Plans

16. Optionally generate a 
Team Participation letter and 
an Allied Health Referral 
letter. Select 
the Documentation tab and 
click Generate button

17. Optionally view/print an 
Allied Health Services 
referral letter and/or Team 
Participation letter. 

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create a Care Plans

18. Set tracking and billing options.

o Assign to another member of the practice to 
review once the care plan has been finished 
(optional).
o Set the care plan type (optional). Each type 
has pre-set expected MBS item code(s). These 
are tracked on the patient and practice 
dashboards, using billing data extracted from 
Pracsoft.
o Set the review period which will control 

when the next review for the care plan is due 
(optional). Upcoming and overdue care plans 
show in the practice dashboard.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care –Create a Care Plans

19. Generate a printed care plan.

o Finalise the care plan and 
generate the care plan document. 
The care plan will automatically be 
saved to MedicalDirector Clinical.

o View or print the generated 
care plan and (optionally) save to 
the patient record it if has not been 
previously saved. The goals, 
metrics, tasks and 
correspondence shown in the 
previous screens are used to 
create the printed version of the 
care plan.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm


TELSTRA HEALTH INTERNAL

MedicalDirector Care – Create or Edit a Care Plan Template Care Plans

MedicalDirector Care comes provided with a 
variety of care plan templates, and you can 
create your own by using one of the supplied 
templates as a base. The following 
instructions cover creating new templates 
and can assist with editing templates you 
have already created.

1. From the MedicalDirector Care widget, 
select Manage Templates.

2. The Template Management window 
appears. By default, you are presented 
with the Supplied tab as shown in the 
example below. The Customised tab is 
where your customised templates will 
appear once you have created one. To 
create your first customised template, 
you must first select a supplied template 
to base it on. In our example, we are going 
to select the Multidisciplinary Care 
Plan template as shown in the example 
below.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create or Edit a Care Plan Template Care Plans

3. After selecting a base for your 
new template, you will be presented 
with a list of patient problems, needs 
and conditions to choose from which 
can be added to your new template.

•Select 1 or more items to add to 
your new template.

•You can rename as existing item by 
clicking its associate           button.

•You can create a new item by 
clicking

4. In our example, we have 
selected 'Recurrent Skin Cancer Risk'. 
Select at least one item to add to 
your new template, and click Edit 
Template button.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create or Edit a Care Plan Template Care Plans

5. You will be presented 
with the details of your first 
selected item. In our 
example, it's the Recurrent 
Skin Cancer Risk item.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create or Edit a Care Plan Template Care Plans

6. If you have selected multiple items to edit, you can toggle between 
them via the panel on the left of the window. In the following example we 
want to edit our Obesity plan details, so we select it here.

 7. At the top of the window, you are presented with the various goals 
associated with the item you selected. The example below shows our 
Obesity item and 3 goals we have associated with it: Bio-Medical Blood 
Checks, Blood Pressure, and Cardiovascular Risk.

 o Add a goal by clicking
o Switch between goals by clicking the title.

8. Under each goal are associated Progress, Health 
Needs, Metrics and Measurements, and Tasks.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create or Edit a Care Plan Template Care Plans

9. You can edit each section of the goal. For 
example, to add a new metric, click

10. Similarly, you can insert additional tasks, click

11. When you have finished editing the template, 
click Save Template button located at the top-right 
of the editing window.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Create or Edit a Care Plan Template Care Plans

12. You will be prompted 
to name the new template, 
and optionally give it a 
description.

13. Click Save button to 
save your customised
template. Your new 
template now appears 
within the Customised list.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Review a Care Plans
Overview
1. Review correspondence, pathology and 
imaging results since the last care plan.

2. Record the patient’s progress and track due 
tasks.

3. Review the team members and generate any 
required documentation.

4. Set tracking and billing options. Generate a 
printed care plan, if required.

Step-by-Step
1. Review correspondence, pathology and imaging 
results since the last care plan.

o Open a patient’s care plan by clicking on the 
tracking summary part of the widget or by clicking 
Open Plan.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Review a Care Plans
o View summary details about the care plan 
with the patient dashboard.

The patient dashboard provides a summary 
view of the care plan including:

• Primary GP.
• Patient demographic details.
• The patient’s overarching goal.

• Critical dates including the date of the first care plan, when it was last updated and when the care plan is next due for 
review.

• Team member participation status.
• Tasks status.
• Billing status.

o The patient timeline represents all the documents which are stored in MedicalDirector Clinical for this patient.

• You can filter by document type or change the date range, to limit the amount of documents shown. Note: the From 
Date filter will automatically populate with the date of the last care plan to ensure that only the documents which were 
created since the last care plan are shown.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Review a Care Plans

Document navigation:

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Review a Care Plans

• You can link the team member who authored 
the document (or role) and then provide a 
summary of their correspondence.

o Linked documents (with summary) show in the Team 
Correspondence tab. Click View to view the original document.

2. Update progress notes and review tasks.
o Record progress notes for this focus area here.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Review a Care Plans

o Mark as complete any tasks which have been done and add any new tasks which should be done on an ongoing basis, 
should be done by a specific date or tasks which should be reviewed periodically to measure progress.

• Tasks which have been marked as complete show in the Completed view.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Review a Care Plans

3. Check team members status, track the 
plan and set review dates, generate 
documentation.

o Review and update team members.

o If needed, generate new referrals or team 
participation letters.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Review a Care Plans

o Track this plan to ensure it is billed.

o Set an interval for the next review.

o Generate the care plan for your records.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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MedicalDirector Care – Track Care Plans

o Review upcoming, overdue and in-
progress care plans.

o Ensure the correct billing has been done 
in a timely manner.
The practice dashboard tracks all care 
plans. The practice dashboard will track all 
care plans that:

o Are overdue.
o Are coming up for review.
o Have been assigned to a user in the 
practice.
o Have been started but not yet finalised.
o Are awaiting on all team members to 
agree to participate.
o Have not been fully billed.
o Are complete, with no outstanding 
issues.

https://www.medicaldirector.com/help/topics-clinical/MedicalDirector_Care.htm
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Your Support Team

Unlimited Support 7 days a week

With one of the largest customer support teams in the industry, we 
offer software support when you need it.

Our team can be contacted 7 days a week via phone or live chat 
available on our website.

Product Consultants for Knowledge & Training

We take pride in the tenure, experience and knowledge of the 
customer service consultants that offer a unique level of 
understanding of your practice.

1300 300 161
medicaldirector.com/contact-us

8am – 6pm AEST Mon to Fri
9 – 5pm AEST Weekends
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Contact
E: info@emphn.org.au 

P: (03) 9046 0300

emphn.org.au

digitalhealth@emphn.org.au



TELSTRA HEALTH INTERNAL

Upcoming Webinar

EMPHN is offering FREE
MedicalDirector Training for Practice 
Managers.

Dates: Time: Location: Enquiries: 
Thursday 8 August 2024 12pm - 2pm 
Online webinar Digital Health 
digitalhealth@emphn.org.au

This is a great opportunity for new 
Practice Managers and current 
Practice Managers to update or refresh 
your skills. 

MedicalDirector Training for Advanced Practice Managers

Register using the QR code or visit 
www.emphn.org.au/newsevents/events/detail/25924

The Training will be delivered remotely by Medical 
Director Trainers and will cover the following:

mailto:digitalhealth@emphn.org.au
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Thank you
A recording & slides of this session and 
feedback form will be delivered to your inbox 
shortly.

Kylie Goodwin
Practice Consultant 
MedicalDirector | Telstra Health
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